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SiRRaEE

BESHHBHENHE  BAEE Frequency) - BEAEEN -
A EXRAaS » SRAMAS -

AR EMEME (Hz) XF# (kHz - 1 kHz = 1000 Hz) » §57%
MEBE » AXREENF 20 Hz £ 20 kHz Z2[F @ PIE ZEBFNWZ LR

EEEHER ; NEHENEXIRE 4 kHz LI -

BERNBETADHMER - BUSZ SN MIDI -

4.2 MIDI
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56 %k Hz, hertz LeISEE AU MIDI, Musical Instrument Digital Interface
EHF Sound card A HC Synthesize RHB Code
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FI4E BE 5

4.3 B\BEEB3

HIEES (Digital audio) RI58xE R - KBS LMEINBIKPHZE
= - BENBISL (Digitisation) 38 12 1 1= 15 22 )% ¥ ¥4 1 BB Ik B SR 1 1Y BUAS
HE ZREMTHENBSBENREZEK  LABBRER FERAEISE

N
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BEHHLNBERE > BAEK Sampling) » TLHBEMEESNEHA -
FEREHE > BENSESVEETZANEE -

AR
T s I

4 BETHELEREE

A. FIEE

¥ X (Sampling rate) BIEEMW B E S EREENRE > W LT
(Hz) REEAL o

g
é‘éfH#

RPABEIMBERBENRSEX  LESEKEEDCHM

RER > 2 x EBNRSEER

EREEBE > AR E S B IR -

—ME @ KEEXEAENERS  EXQY - BFARENEREEX B
BENMNBEZNENNETETANEETE -

FEL  EEMARMARRE 20 kHz - EMREXKRETE (CD-Audio)
AEREE SRR 44.1 kHz (44.1 kHz BEHERN 2 x 20 kHz) ; 0%
(b) AFERIERRE - HRIRERRFE 11.1 kHz (A EHRRZENERSEERE 4 kHz »

11.1 kHz 2848 2 x 4 kHz) °
5 EEEE
(a) EROIRIE R
ORTE S

RS, Analogue wave pattern AEAE Discrete 57 g ‘
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B. #&&X/

EEEREEE  HEESPONE L TR - AKX/ (Sample
size) ﬁi‘%.ﬂ?ﬁtﬂﬁlhzﬁﬂﬁifﬁﬁﬁ%E’\M\‘Iﬁ:%% o BRRANM - —L2IF
BENNFEEESHEET - B AR - ALt - BUSEEMER - BRI
IR K SN - IFHKJ%EN@ZIUVJ\ °

—RME @ HAEBEZLL 8 ALK Ek ; HEFE (CD-Audio) L 16
TR H  FXEHFRILL 24 AITRDE ©

PP E S AR
AL 1.7 {1l (kHz)  8-fzyT (bit)
et E 44.1 {1l T6-iLjT
S-S5 44.1 {1l 24T

®1  TRANBEHRERMERKN

C. EEEMIIREE

BRNGERBE—HHIMHIR - EHRFREMMEREE (Chan-
nel) - B {E2IIFEE (Stereo) » ZERSREARMBET  HEREH K

BEKREE  BEEZEEE Mono) - ALt ﬁﬁ%%ﬁ%%ﬁd\mi%%
IR -

D. HEETFERXN)
STEREBERENAD  UFHAER > TENT

BEAN = BBEHE x KRR x KEKX/) x 5@ / 8
(

BN ERIRERRZ 44.1 kHz AIRARKNZ 16 AT - BB RE A
— /N o AT RIE  SIERKBHBIERER/N -

(@ BEEEEBE

(b) BERIMERE

(a) NeREBEBEET R —GE2E  Hit
FERA/N = 1x44.1 x 10° x 16 x (60 x 60) 77T
=2.54 x 10° AIJT = 2.54 x 10°/8 =2
=3.17 x 10° =& ~300 MB
(b) HRIUIBEBNEET  BEXKNEERFHR - BEt2E ~600 MB

MEGEE Spoken voice HEEPRE Professional recording
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E. BlEEESR

RAEBARENBISREEEL WAV B KEE - FIEAMNEITER—
MACTEFE K ©

BT ELOBRE LEE  VWEKIBERG  EANEBEESXEE
EEFHETWE 3 MP3) »

MP3 B2HEBEENBMERM - LEARNE DB o (£F MP3 KEHE
HEREE (CD-Audio) - BELLAISE 12: 1 MBFERBEMAVELX -

5 2 — R CHRREFRT KRR 16 EARK BRI » L MP3 RIE T
Rizir - AIFETZOEREERR

& : HR MP3 HERARLERZ 12:1 @ BERGETRVMBER 15 x 12 =
180

F. fiijgiE==E

i TSR (Bit rate) CREBIEEMNEE - WABW S A AT (bps) E
o Bl EBENKESTE  REXZE 44.1 kHz » TRAKNZ 16 AT o
Rt - SR NBER 44.1 x 10° {8 16 AITTAIEAE - FTILUMITTREZ 44.1 x
10° x 16 bps = 7.056 x 10° 3 705.6 kbps °

fIRE = BBHE x REE x BEAK/N

BEERR > ABRBEFTMEBEARFHD TS LEXIETRF -
It BHENREVAAS » e UEEEREE - SUNBSTERRE
BRLMRISER -

BHENTFATER FECITRE B

6 EEEBEHNREEE -

i1 3 SHEE R — S AN AN 16 bit ~ XA 44.1 kHz (37
BETUMAENAITEE o
7 R TEIEER = 2 x 16 bit x 44.1 kHz = 1411.2 kbps °

i Transmission N TCHEF bps, bit per second  HZ(F Sound card B Live 59 g l

T #8% Stereo BEHEFHEWE 3 MP3, MPEG-1 Audio Layer-3
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& 12 MIDI BB 2 883E
& SMEIE MIDI 1=

HEBEE T - (RGER—@ MIDI fRERFRRES —RHEAVL
B NEERHANES  WHRAMESTES -

Anvil Studio®

Anvil Studio® 2 —BERERZ%E MIDI FEERNRELRM o R
FAlE AT - —HEFEE MIDI BBEF o FEERE > IRINAIRIFY
WAV IR HMEB E - RAEREEFELET - Anvil Studio® 2—
BEEENEETR  BWIREESKEENBB2ENELRER -
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1. BEFHNERZEISHNF  LEEE
ERRNBES -

2. RNHEALZEE Anvil Studio : Serious about s techjobrig

ry = Ty Bl eyl b

o EF "http://www.download.com"

o 185 "Anvil Studio"

s THEHEMROZRERG

s BITZRERIV A
AlNE==

Anvil Studipfl_—— —_—_— —— ——

vl il ety %)
ol e CE=]

— g e
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EX&) Anvil Studio :

o B—TK BB » FTBEEI » Anvil Stu-
dio

SRINEHERR : BB Mixer) » RTS8
(Composer) & MEAMREE (Lyrics) &  BBRF 1M
RimE—1@ MIDI 185 » Rt ERIRTD SR e S
TE -------

2. BARN THREEEMIR (Composer View) |
* BT RIR (View) > iR
(Composer) 8 -
* E—F #RE (Compose)

II.HI.HJI. ML IJLI.IJI.HI.I.LII.HI.H.I

EOIRE LN LEST  BMERE (IFAR
HESE00 MIDI ) 0T :

FiE 1
BRERENSHEESOMS

ESTRNEESSELE  —@RLLS
SHEHBOESELLIR  RZIMK -

FE2 ERERSLHESR

s BFEEEREEREEARLEZNM
Bk

s ENERL—E3F

s ABBEERLE—T

II.HI.IHl.lILI.HI.I.JI.HJI.I.JI.I.HI.HI.I.H

1. HEORELNLET  TRAOTNBATHS
% -]

2. BHEg:
s BHHBEMIZMHERLMABMS
o E—TN W (Play) 2R (l2)

Auld Lang Syne E: :
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1. BERUESZRWIR -
o IE—"K iR (View) » BB (Mixer)

2. BARN "MBIFTAELES (Select Synthesizer) iR

&,
o B—TF&E "B8 1, (Track 1) L4231 (In-

strument) NEBHVIB B oy oty i
.. TBIZFT A ES (Select Synthesizer) TRE 5 58 E=_'T.=:=:;:‘m=—'—

. REEEEHMRESE
e E—K BE (OK

3. BRENSY EEBEEDH -

NEVmEESSRIRIRIES Y LT - BRI HREE
_%,Dj o

1. BARR "MEIREESS L (Lyric Editor) :
o 1Z—F WiIR (View) » 5T (Lyrics)

2. BANGCBERRONGD -
FiE (=) ERRDBREFPHXF © RN
AEMREFR (KD BXF BRI
WITEDEZK ©

3. FARA "MEIMREFEZ 4 (Lyric Editor) :
s ¥E—TF®E (OK

4. RIRDOIREE LHVMET ¢
* BT RiR (View) > {RF52E
(Composer)

© ORBARE OB Lyric) el

5. IBIWMEE:
o B—TK 1B (File) » BEBEE (Save
Song)

o B "Auld lang syne’ Ill]llJllllllJllJlllJllILllJllJLllJ

s B—"K =Z18 (Save)

LB
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LR o 35 A 1 NI A

HIBA\SESNESEN  BMENE
FHiE1 B

RIBIZ IFEAKET (Insert Mode) e RE 7 (KL
SRFIENSHTEE RN -

FE2 ERERFLOZSH

123 Shift AR IE— T EZRLENSSRN
BESHE -

RBEESSNESHLE UNEMR

g di

. Auld Lang Syne
-
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9 & E A MIDL B A
FREIERE B
7 A M S o J
FRGEEE Anvil Studio -- ST+ H
http://www.anvil.com #z{it

=% MIDI 723518 » Anvil Studio® AR L WAV L5
B o

EEIS]EY)

FOEEBIGENE - 1RIGEESD

¢ E MIDI SEEWT - HESTHEE—E WAV 1R
& RE WAV IBE  BRE - MIRUES —@FR6ED
¢ ERTHESHNSHNEE
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1.  BX&) Anvil Studio :
o B—"TF B » FTBEEN » Anvil Studio

2. FHRBIRBERIIHRN:
© HE—TN HE (File) » RAMEZE Open
Song)
* 3EJE "Auld Lang Syne"

2

SR BRI —HKRENSH - BKS
YFM MIDI SRENHRS  BARBRNESH
BRI —EBILOER -

1. RBEHE—FIH:
e J2—F TE (Track) » FIZ (Create) »
EHEH (Audio Track)

Te b ad §aug bam o e, tici e T pass a e

T < i G oD T e e
2. Eﬂﬁi MRS R Mixer) IRE ,
B— —F &R (View) » BZE (Mixer) hﬁ#-hh_mchﬂ#hh
o £ IREE Mixer) JTH@J:, SBIZ S 2 S —h--—m-n-ﬂwm.
2 (Track 2) Tenamia “-l:-- -

R 0 "Aulde_Awav' 2EETHS0—1E
FRRE - TAGRER  B3832
"Aulde_B.wav" U0 ItL X8 HE o

3

1. S TREVMER -
e JZ—T 85 (Record) 28R (|BeC))

© HEZREBENE TS "‘“"“""'\

il e i
s ENIEERIZ—T FL (Stop)(m) B b s a T —

T
P P el g i ol B e, [k
e el e o L e

ERNBEAD  TRRESHEE # | |l

BEBEHES - - hoane / |
T -
[ — e ] - il
= .., T r ;,:.i: FrprT

e e . e
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P s Fom 8 (")
Tk
ey Do
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P S ) Micrnss
AT

A
AR SO EABOETESE - fl | e emme =
BH MRARSHBES - EASHEE EH| 4 —m.—ﬁﬂ
=
1. BREFENDD : : =
2. BTAERETRNBH -
3. BEFOME
4.

e
i/ ABS £ (Paste Insert) ~ B & (Paste) 3§ i =
B85 £ (Paste Mix)

1. FRURFBERRE -
o JEIE BE 2 (Track 2)
* B—T RR (View) > iR
(Composer)

8 #— T #RE (Compose) 1R $H

2. RAEREHOIBD
- BRBERUBREOVID

3. NERREIKN -
s HERBHUEENE

RTH R ROV DN EBENFES @ BEEE
RBHF o RNESH > SYRMBESHRNS
R -

1. IBINEENSE 1
e E—TF BEXE (Louder) ( Low )

2. HAEETE:

e E—F B2 (Volume) ( ¥ohma )

o PBEBEFEMUE [ .
T Mol g | 7

¥ —F &F (Pitch) ((Fen )

. FABBHRMSB T
4., EHERMBETOHES -
5. BREEEE-
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SigRemE

o HiE

1. BRITOHHeEEETA -

MIDI 4 £EF0r — L THELZELANTH -
HAEETRGTS BHBEREENTHTOES -
BREAREEDN > BRAZERMZHORE -
NHBEEREROM AR ERAKRERAKR D -

EHE LA AR RS BRI E -

MP3 RAEBHBEHMN > BHELTHE 121 -
BHEEWMOREBAMARE -

© N o u b W

ZIREERS 4. PUSICETENE T E T —{E MP3 fEE -
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HEZ A R E] WAV R 20 o TN IR IE #
aft f2 ¥ FY 2

HH 5 HENTY . THNEYAEER Ty B e B 10 (5
S 2 2 (2)  RRHT WAV B EFEERE MP3
A. MIDI B 969 WAV 4% % 2 52 2 4 69
B. WAV , (3) MP3 %2 —{d MIDI &%
C. RA (Real audio)
D. MP3 A, HE (1)
B. HE (2)
C. HE (1) 1 (2)
Jiuj#%‘ 5 ﬁ%ﬁiﬁﬂ/‘j%ﬁﬂﬂé ’ TﬁU%B*EﬁZﬁ%?gHEE D. R;E‘ (2) %D (3)
DR ZRRE 2
A. MIDI 5. FHIMPTER R MP3 2 A R 2 i 2
B. WAV , (1) MP3 2 MIDI % Z i 58 4 iy
C. RA (Real audio) (2)  MP3 AHEAL & B R LA
D. MP3 (3)  {ERERUET » MP3 25 R R A
A HE (1)
TR E 2 AT AEHY 2 B. WA (2)
(1) ?Egﬁgﬁgﬁﬁ M|D| )fﬁ% C /Eiﬁ (1) %D (3)
(2) TE M|Dl 7{%’%@5}@% WAV %% D Rﬁ‘ (2) %D (3)

(3) AR R Ry ] e 8 Y ST

A HE (1) (1)  MIDI

B HE () (2) WAV

D. HHE (2) M1 (3)
Ao HE M)
B. HA (1) M (2)
C. HHE (2) 3
D. (1)~ (2) fI (3)



1 ] ﬁ.
FI4E BE 5

TYIpRERE A FE LS EREFTC 9. WAV f#E 188 8 IR A
W R fE 2 (1) BRERR
(1) MIDI (2) AR
(2) WAV (3) WEHEHEEE
(3) MP3
A. HE (1)

A. HE (1) B. HE (1) #f(2)
B. HE (2) C. HE (2) #(3)
C. HE (1) f1(2) D. (1)~ (2) # (3)
D. REH (2) #1 (3)
T %R A A ZE A X B A R R R R 2 10. SR HIE ZBIRR
(1)  MIDI (1) BRER
(2) WAV (2) AR
(3) MP3 (3) BEHEARFIVHEE
A. HE (1) A. HE (1)
B. HE (2) B. HE (1) 1 (2)
C. HE 3 C. HEFH (2)# 3
D. HEH (1) # (3) D. (1)~(2) 1 (3)

[ & =8 EE RN METRIRARACEGHNE -

1. HWEMEE R ZH - BRI —EER - LREELE - 8
{8 B %2 B B A R AR - DA BB EE & Rt — S e A+ - Bl T RLGF
ME 2 | o
et Y B A R B EE S B B TGS AR T Am B - TEE B A
E%ﬂﬁuaﬁ%ﬁaﬁ“ﬂi 28 A R (5 ) - W R 2 S A IR i 1 S B T 0 AT
g -

(@) R NHILIE - BHFT AR -
o B
i MR (2 93)

(b) RIBTHNRIE - Pl bl iy =A% = -
) FTERERITEM

i) BEFEIIERA (3 53)
(c)  &YGmiEEE S B ME B REFIERES - (3 7)
(d) 55 H % s B JCRT ] M &) 1 e 7 O RO 1 o R T 2 e [ PR 4 T IR 2 X
(e)  BISHYH A /i fE A+ HF %Di*I%% ° @%%%Eﬂ?—ﬂﬂﬁ(?ﬁﬁ’)
A58 S Re 15 P A HY) (81 B A o #0 E S S BEUR H K - (2 97)

() BETEMEEE T A —(E R ARt S E - 258 40 n] 1] A 5% i 8 2k 2K
=R A (2 47)

-
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KR — (B AT 5 0 A SRR BB - IS R
DUOCHE S B E £ S % SRR T E R RS ET e A
EN R

() HEPDLHREEERMDMFEETERBRNNEST - SHEMER
TELRBE A Ey T - (2 93)

(b) REFREH & B FH S G S AE -

P B HURCRE g R Y — A AR A (143)
i) R R A B = R S RE R A B B TR R R R R

e O i 1 S 2 o (3 93)
iii) EE%%L’@E%%%%@%ﬁ%ﬁ°ﬁﬁﬁfﬁﬁf%)

() REHFARKEEMES - el DLEFREE - /Al UL EE -

) RUREEBEMNIIEEAESR - (2 43)
i) EMIEREANNEREFE 2 (2 73)
i) BHMECE  RPEMERHTITEREES - (2 43)

RRFPATE T B E - W H DVEE P AR —EEEN - B
REEBARBEZEE - FHit5aE S BlBE0HERT -

(a) EEFEEBEN - MEIATHRAE T KM T - ENHBEREFTOENR
T dtl A (T A B P ek O R R E T BEAS ] 2 (2 43)

(b) HRFEREETLUCREENE R AHREMAES - SR EHE R
K- BE=EENMEETTE - (3 7)

() ERBBEBEETRER R EETHEAEEHEN
IR b 8 5 e R R B 25 1 R N7 43 B b b R B A O A UG o fEBIE B
B BENHEES LIRS RBIR ? &2 REEZER
fif 2 (2 47)

(d) FREKHWBESESEHEN MESTFEEREHER . &
WeREsE 0 Y HREAN TR o FIR WA REME E M 1955 5 A E)
A (3 47)

s
A}

A —EEEER  TEAEFRERTE -

FEREGARRREISFAONETRER Y E2NEG  SHAIHNE
REEEEBA - (3 77)

)

—
—
-

B G T AE — e iR L - R A TR R R A B AR A O R
E 7 ERAEE - M FE AL AT R IS Y (2 93)
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FI4E BE 5

KZREBSKE LEERTEEN—EFW - \%RK > MREHEKE
BEEIETRE TS -
() MBTEMEEUKFRREETE? (1 93)

(b)y KRR AE MIDI S8 o SFHIREF I RETIE - 32 i 2
MIDI §# # [E] Y 2 R - (2 57)

(c) MIBESERRETLS%Z » DIRERK - MIDI AT WAV » 551 -
i) DL EmpfEfE A A B Em AW FETFE 2 (2 4%)
i) FYIEAEEEN WAV RS 20 R B

EE A #EiE B #EiE C #=ZD
REEAR 44.1 {FhfkHz) 44.1 kHz 11.1 kHz 11.1 kHz
BRAK/N 16 fiJT 8 firjt 16 T 8 firjt

ERZRGHRENTEER - tELH L LW E=ERE

(2 )
i) HEBEMBTRN MR T R - MEZE L W
118 1 2 2 i e ot AR R AT (3 73)

(d)  FIFENZEWEK > tth SECEE WK - B FLRERER - HIFENERL
A TR A A HOE %R
i) ;f'J 5 P A TR 2R AU B S B A 2 (1 53)
i) ENZHBEIEAMBRIGH T - Samek? (2 9)
iii) f’Jﬂ*ﬁ%ﬁ%i AR - BB T HEMRE? 2 D)

if&lﬁﬁ%ﬁ?*?ﬁﬁ:ﬁ;ﬁ ° SECIRIUE T it i & 2 T AU - ﬁﬂaﬁf%ﬂﬁﬂ
fECHR B AE E - DLBEIn A — SR B SCR  BIANNE B3Rl (D)) 284
ﬂxtﬁgﬁ%ﬂ’]x&%

(a)  FH7 A 7R I o B St 2 A A A A SR 2 (2 97)
(b) D) fE#EHE EEERITHCR R RS > B U &K - BE ’ET;R
150 FH 78 il B ¥R GE R SCR - 3 47)
(c) S HEUREHMEWERS L - HEIRS T AR AW & K
EE NG (2 97)
(d) I E#ER% > ERETED MP3 R EEHE - 6 DUE B2 45 it 5 AR
i
D) R ER AR R E T ORE R T R (X (1 43)
i) MP3 HYEEHE L RAT R D 2 (1 93)
i) R R AR R (LAY (2 73)
iv) B HIBRE A S AT — R RS - (2 73)

V) EFEZEBAEELE - MAE MIDI IR 8% 2/ ERT DL
PP — B RGRE b - A2 m ih bR MIDI #5204
WBERE - R B ER G BRI EE 2 B2 (2 4)

-



